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 Release Notes for Inpho 12 
 

Trimble Inpho Version 12 

Trimble announces version 12 for all Inpho software products including UASMaster (separated release 
note). Users can find the following products in Inpho 12 as modules in ApplicationsMaster: 
 
MATCH-AT automatic georeferencing (including inBLOCK) 

MATCH-3DX and Meshing Add-On for automatic generation of 3D point clouds, true ortho mosaics and 3D 

meshes 

MATCH-T DSM automatic 2.5D point cloud (DSM/DTM) generation 

DTMaster Stereo interactive and automated editing of point clouds, DTM/DSM and basic mapping 

OrthoMaster ortho image generation 

OrthoVista automatic ortho mosaicking, editing and color balancing 

SATMaster complete satellite imagery workflow 

 
 
 
Users with valid maintenance will receive an update file for their licenses. More information can be found 
on the Website: 
https://geospatial.trimble.com/products-and-solutions/inpho 
  

https://geospatial.trimble.com/products-and-solutions/inpho
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What’s new in Inpho 12.2! 

Better performance in MATCH-3DX for true-orthophoto and mesh generation 

The overall processing time in MATCH-3DX is up to 15% faster than the version before.  
In this process, DSM and true-orthophoto can be generated up to 10% faster than before. In generation of 
meshes, users can expect up to 10% in 2.5D mesh an up to 15% in 3D meshes. 
 

Usability improvements for coordinate system management 
In Trimble Coordinate Systems (TCS) it is now possible to search for coordinate systems by name, EPSG 
code or country. In addition, it can be defined where the coordinate systems are to be saved. A list of 
recently used coordinate systems is also added in this version. Furthermore, TCS is now updated to the 
recent version. 
 

Significantly speed up in project setup and data handling 

Considering the rapid increases in project size (more projects with larger images and larger number of 
images), project managers should transfer the data between storage platforms quite often to free or clean 
up these spaces. In Project Editor, there has been the possibility to change the path of the images on the 
drive. In the new version, this change is now significantly up to even 100 times faster than before. This is 
very important for large and multi head projects. 
 

More usability improvements in project setup 

In this version, there are some improvements for better and insured management of strips, while 
importing a GNSS/IMU file with predefined strips. The new version can automatically assist operators, if 
the strips have a unique strip separator, if users would like to write their own naming on the strip names. 
 

Better control of camera with the 3D distortion plot 
In addition to the comprehensive report file, users have been enjoying the visualized 3D plot of camera 
distortion. In this version, this 3D plot can be shown immediately and more meaningfully. Another usability 
feature in this version is a new slider for scaling the V- and Z- factors in the 3D Distortion Plot for easier 
operation. 
 
As usual, we are happy to improve the stability and usability of our software by some fixes in this version. 
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Other highlights you should know about Inpho 12 

 

Stronger AT processing with the new image matching engine in MATCH-AT 

Inpho version 12 offers a new image matching engine in MATCH-AT for stronger and high-performance 
aerial triangulation of large and high overlap imagery projects. More robustness in image orientation of 
challenging areas like forests as well as increased level of connectivity in tie point extraction from 99 to 999 
folds are the other highlights of this new engine. Furthermore, users can benefit from the improvements in 
the accessibility of images during image matching for more productivity.  
 
More productivity and improved usability in MATCH-AT 

In the new version of MATCH-AT, users can feel the significantly higher performance of loading images 
during the project setup, and increase the productivity from the beginning steps. 
Additionally, thanks to the automatic detection of working space and adapting during the process, users 
should not have concern about the continuity of the process if the specified values are not high enough. 
There are more usability features in Photo Measurement Tool (PMT) such as new shortcuts for measuring 
modes, new export capability of selected points, and faster start-up, as well as improvements for better 
working with viewing windows. 
 
In the new version, users can find a comprehensive description of camera parameters in the MATCH-AT 
report, for better quality assessment of the block adjustment. 
 
Improved usability in MATCH-3DX 

In the new version of MATCH-3DX, users can benefit from the new image checking capability at the 
beginning of the process and save processing time by excluding non-validated corrupted images from the 
process. Furthermore, automatic determination of the most suitable settings, leads to ensuring the quality 
of deliverables for more efficiency in production. Optimized multi-threading and usage of available image 
pyramids are the other highlights of this product in version 12. 
 

Higher quality and more efficiency in MATCH-3DX products 

True-orthophotos in this version can be generated with more homogeneity and balanced radiometry. The 
new version of MATCH-3DX delivers a cleaned-up final mosaic by automatically generating a borderline, if 
not pre-defined. Furthermore, the quality of true orthophotos of highly distorted images is increased, by 
selecting the best part of the image in orthophoto generation. 
MATCH-3DX Meshing-Add-On version 12 offers higher quality in 3D meshes with more sharpness on the 
edges, as well as enhanced texture on the model. Furthermore, the reduction of triangles in the multi-
resolution geometry helps to produce more efficient 3D models for better streaming and optimized data 
storage. 
 
Faster streaming and more efficiency in handling of 3D meshes in MATCH-3DX 

In version 12.1, the number of triangles in meshes is significantly reduced (up to 10 times) which is 

important for data transfer, office-based visualization, and web-based streaming purposes. In this way, the 

graphics memory would be efficiently used while keeping the quality of the geometry untouched. 
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Furthermore, due the up to 50% reduction of the size of the texture files (texture atlases) in this version, 

less memory is needed to handle the 3D textured meshes for seamless representation photo realistic 

models. Additionally, in this version the visualization of 3D meshes are smarter managed, as the 

foreground objects are loaded faster (up to 2 times). These improvements are specifically important for 

the users with very large projects or with weak processing units (CPU, GPU), or slow internet connection. 

 

As the compression of the JPEG textures is optimized in this version, the OBJ and DAE meshes are more 

detailed and have better quality. In this version, the Draco compression is disabled by default, which is 

beneficial in increasing the performance for streaming of the 3D tiles of meshes in Cesium or similar 

environments or for the desktop visualization on low-end hardware. 

 

Cleaned up true orthophotos with improvements in performance in MATCH-3DX  
Due to the automatic definition of borderline for the area of interest since version 12, the final true 

orthophotos look very cleaned up. This improvement speeds up the processing, as the DSM and 

orthophoto generation will not happen in the background or useless areas. 

 

Usability enhancements for more GIS ready deliverables from MATCH-3DX  
Another enhancement for the large projects is that the information of the stereo models is stored more 

efficiently from this version. This means reduction in disk space, better data handling and optimized usage 

of memories.  

In this version, the users would enjoy efficient representation and usage of MATCH-3DX results, e.g. DSM 

and true orthophotos in GIS environments, based on the virtual raster files (VRT) that will be from now on 

automatically generated and delivered. Furthermore, providing the tile shape files with ID (based on the 

tile coordinate), users can have a better overview on the whole projects and find the position of the tile 

files by loading the TileShape.shp in a GIS environment like ArcGIS. 

 
Better performance in MATCH-3DX 

Beside the higher quality, faster generation of DSM and true-orthophoto, as well as parallelization of the 
image rectifiers in this version increases the level of productivity with MATCH-3DX, which is particularly 
important for large and high overlap imagery projects. 
 
Better quality of point clouds and more flexibility in MATCH-T DSM 

Users of the classical workflow, who employ MATCH-T DSM for point cloud generation, will expect less 
noise in the final products. Furthermore, the MATCH.status file can be accessed easily via the user 
interface. For this, we highly recommend enjoying the consultant of our support team. 
 
Significantly better performance in OrthoMaster and background transparency in OrthoVista 

The processing time for orthophoto generation in OrthoMaster is now 2-3 times faster, which levels up the 
productivity for the users who are using the classical orthophoto workflow.  
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Additionally, transparency of background pixels can be now better handled by adding alpha channels in 
OrthoVista. 
 
Usability improvements in DPMaster for distributed processing 

In version 12, multiple processing jobs and their dependencies in MATCH-3DX can be organized easier in 
DPMaster, to better scale up the production for large projects by distributed processing. 
The expanded data transfer to image files and orientation files, in addition to the basic job files in MATCH-
3DX and OrthoMaster, helps better and efficient data handling from the job creation to the job 
termination. Another usability improvement in this version is the possibility of changing the target 
machines after submission of the process. This gives the user more freedom to trigger the job to another 
machine if the original target machine is busy. Thanks to the new data management improvements in 
DPMaster, users can enjoy the structured directories and easily track the corresponding files. 
Just as a reminder, DPMaster is available for MATCH-T DSM and OrthoMaster with favorably Distributed 
Processing Licenses (DPL) as well as for MATCH-3DX (with full licenses). 
 
More usability improvements for seamless workflow 

In Inpho version 12, users can enjoy more usability enhancements in ApplicationsMaster such as, 
automatically selection of additional (stronger) graphics cards to the on-board GPU, parallelization of the 
Colorizer, and new setup options in Camera Dialog for analogue images of Wild cameras  
 
Integration of Trimble Coordinate System  
Considering the worldwide coverage of Trimble Coordinate System (TCS) with various projection and geoid, 

Trimble Inpho and UASMaster workflows are now empowered by TCS. As this coordinate system has been 

used in many hardware and software within Trimble, this integration supports our users, to not only enjoy 

this comprehensive coordinate system, but also better handle the data within Trimble world. We highly 

encourage our customers to use Trimble Coordinate Systems for their projects. However, for the transition 

time to replace the Inpho Coordinate System (ICS) with the new one, and collecting your feedback e.g., any 

compatibility purposes for the older projects or your wishes on completeness of TCS, we will keep the 

Inpho Coordinate System (ICS) in version 12. 

 
 
More information can be found in the Release Notes and on the Website: 
https://geospatial.trimble.com/products-and-solutions/inpho 
 
New users can contact their regional sales managers for purchasing/updating new licenses or requesting 
for evaluation licenses: https://geospatial.trimble.com/where-to-buy 
  

https://geospatial.trimble.com/products-and-solutions/inpho
https://geospatial.trimble.com/where-to-buy
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List of Changes 
 

Changes for SATMaster are aligning with changes in the Inpho components associated with satellite 
processing (ApplicationsMaster, MATCH-AT, MATCH-T DSM, DTMaster Stereo, OrthoMaster, OrthoVista). 

Note: In Version 12.2 the project file version did not change. Furthermore, projects from Version 9.2, 10, 
11, 12.0 and 12.1 can be used without conversion. 

Note: Version 12.2 does not need a new license if you work already with version 12. 

Version 12 required a license update. Customers with maintenance automatically received the license 
update. A valid license for version 12 works for versions 11.0.5, 11.0.6 and 11.0.7. Older versions are not 
supported with the new license. 

 

Information: In order to be able to use the given hardware better, MATCH-AT, MATCH-T and OrthoMaster 
now use 40 cores and MATCH-3DX 48 cores for computationally intensive steps. This makes no sense for 
I/O intensive steps, which is why not all cores are used for the entire processing. 

ApplicationsMaster 

Change Description 

WIBU Codemeter 
vulnerabilities 
 

WIBU systems provide information about current vulnerabilities.  
We therefore urgently recommend installing the latest driver, which can be 
downloaded from the WIBU Codemeter homepage or from our download page 

under 3rd Party Products. The bundle installer of version 12 is equipped with 
this driver (7.40).  
Note that the driver will not work for WIN 7 operating systems. The latest 
driver for WIBU Codemeter dongles for Windows 7 operating systems is 
7.21a. The driver can be downloaded from the WIBU Codemeter homepage 
(www.wibu.com / www.wibu.de) or from our download page under 3rd 
Party Products. 
 

Improvement 12.2: 
Project Editor 
performance 
 

The time it takes to change the path of images or remove images has been 
drastically reduced. 

  

http://www.wibu.com/
http://www.wibu.de/
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Improvement 12.2: Added 
functionality for TCS 
 

For Trimble Coordinate Systems it is now possible to search for coordinate 
systems by name, EPSG code or country. In addition, it can be defined 
where the coordinate systems are to be saved. Also added is a list of 
recently used coordinate systems. 
 

Improvement 12.2: Strip 
ID generation 
 

Importing a GNSS/IMU file with pre-defined strips, now the strip 
numbering will be handled as following: 

Case A) Unique strip separator texts will generate strip IDs of their text 
string 
 

 
 
Case B) Missing and ambiguous strip separator text strings will generate 
strip IDs with a primary sequential number followed by the strip separator 
text. The sequential number has the same number of digits, e.g. 1,2, ... for 
up to 9 strips, 01, 02, .. for up to 99 strips, 001, 002, .. for up to 999 strips, 
etc. 

 
 
 
 
 

Case C) For strip separators without text string a sequential number of the 
same digits is generated. 
 

 

Improvement 12.2: Tool 
“Vector File Information -> 
PDF” 
 

The Tool function “Vector File Information -> PDF” offers now additional 
options: 
– Additional statistics for DTMs 
– New output options: 
           ▪ Report separately for each input file  
           ▪ One report for all input files 
– Additional output format TXT 
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Improvement 12.2: 
Detailed information 
when TCS wasn’t installed 

Opening a project with defined TCS project coordinate system, the Project 
Editor commented only an Error -10 if the Trimble Coordinate Systems 
were not installed. Now a better description leads the user to the cause of 
the problem. 

 

Fix 12.2: Single point 
transformation 
 

When converting files from a projected system to a geographic system 
using the file format XYZC, the resulting Lat/Long coordinates only had 
three decimal places, which is a too imprecise positioning. Now the 
Lat/Long values are stored with 9 decimal places. 
 

Fix 12.2: Image Converter 
failed in batch mode when 
using special characters 
 

The generated batch file could not process some special characters 
correctly, so the batch file has now been converted to UTF-8 
interpretation. 

Change 12.2: Interior 
Orientation – Icon for 
“Define Measurement 
Cursor” changed 
 

The icon for opening the interface for creating a user-defined 
measurement cursor for the manual fiducial mark measurement has been 
updated because the previous icon was too small. 

Previous icon: 

New icon:   Open ”Define Measurement Cursor” menu 

                                  Close “Define Measurement Cursor” menu  
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Fix 12.2: Interior 
Orientation – Image 
Coordinate display not 
updated correctly 
 

During the manual measurement of fiducial marks for analog images, the 
image coordinates were not updated correctly. Users had to click multiple 
times to receive an update.  
Now the coordinates are displayed and updated while measuring or 
moving the mouse cursor while having the right mouse button clicked. 
 

Fix 12.2: Interior 
Orientation - 
Representation of the 
largest residuals 

In previous versions, the highest residuals in X and Y were highlighted in 
red in the manual IO dialog. This was no longer the case in the last 
versions. Now the largest residuals in X and Y are shown in bold. 
 

 
 

Fix 12.2: Tool > “Vector 
File Information -> PDF” 
crash 
 

The Tool function “Vector File Information -> PDF” crashed immediately 
when importing a large amount of DTM files (>100), which is fixed for 
version 12.2 

Fix 12.2: TCS visibility of 
coordinate systems 
 

For Trimble Coordinate Systems it could happen that not all available 
systems were displayed when searching for coordinate systems for a 
“country”. This is fixed. 
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Fix 12.2: Project Editor – 
strip generation failure 
 

The alpha-numeric sorting of images was not working, therefore the strip 
generation could fail.  

General: 
The strip generation will not work, if the alpha-numeric image IDs are not 
uniform, e.g.  
xxxxxxxx_xxx_?x_xxxxxx_xxxxxxxx_xxxxx_xxxxxxxxx 
20190607_001_1_064644_00125488_TA004_064644089 
20190722_019_19_053713_00125488_TC004_053713425 
20190607_002_2_060836_00125488_TA007_060836655 

It would work with 
xxxxxxxx_xxx_xx_xxxxxx_xxxxxxxx_xxxxx_xxxxxxxxx 
20190607_001_01_064644_00125488_TA004_064644089 
20190607_002_02_060836_00125488_TA007_060836655 

20190722_019_19_053713_00125488_TC004_053713425 

or using the “Identification extraction” and deploy the section from 
position 33 (for this example) to create IDs with ascending increments. 
 

 
 

Improvement 12.1.1: 
Warning when importing 
points and measurements 
  

For the case, that “Points and measurements” are to be imported (Project 
Edit) and the type of the coordinate system (TCS/ICS) does not match, only 
the point measurements are imported. A warning appears with the 
following text: “TCS and ICS coordinate systems cannot be mixed. Only the 
image coordinates are imported. Object coordinates must be reimported 
from the original sources.” 
 

Improvement 12.1.1: 
PhaseOne PAS280 camera 
 

The PhaseOne PAS280 camera has been added to the camera database. 
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Fix 12.1.1: Occasional 
Project Editor crashes 
 

Occasional Project Editor crashes have been fixed. 

Fix 12.1.1: Reset function 
for “Frame Photos”  
 

After renaming the path of the images, it was no more possible to reset it 
to the original path names. The Reset button had no effect. Now it works 
again. 
 

Fix 12.1.1: Add A3 images The Project Editor closed without prior notice when adding A3 images. The 
data could be loaded via the import button. In version 12.1.1 both ways 
work again. 
 

Fix 12.1.1: Colorizer and 
multi-threading 
 

A problem in the multi-threading of the Colorizer is fixed. 

Fix 12.1.1: Crash in 16 bit 
pyramid generation 
 

The overview (pyramid) generation (make_pyr.exe) for 16 bit images is 
now possible again. A bug from the previous version has been fixed. 

Fix 12.1.1: Bingo import Importing tie points in Bingo format showed an empty photo dialog. 
Nevertheless, the import was successful. Now the photos and exterior 
orientations are displayed directly when importing. 
 

Fix 12.1.1: Project Merge 
with identical camera 
 

A crash during Project Merge with an identical camera ID has been fixed. 

Fix 12.1.1: Uninstall 
version 12.0 when 12.1 is 
already installed. 
 

If version 12.0 was uninstalled while versions 12.0 and 12.1 were installed, 
it could happen that entries that were still used for the remaining version 
were removed, e.g. the symbols of the ground control points. This has 
been fixed so that all icons are available after an uninstall. 
 

Fix 12.1.1: Image 
Converter – JPEG2000 
 

It could happen that when using JPEG2000 images as input format and 
defining “same as input file” for the organization, the generated TIFF 
output file was incorrect in the original image resolution. This has been 
fixed. 
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Fix 12.1.1: Crash in 
ApplicationsMaster > 
Tools > “Vector File 
Information -> PDF” 
 

The ApplicationsMaster Tool function “Vector File Information -> PDF” 
crashed when importing multiple files.  

Information 12.1.1: Error 
message or crash 
appeared if TCS was not 
installed 
 

The Trimble Coordinate Systems has now been made available in the 
download area. TCS is part of the bundle installation but installing the 
individual .msi files also requires downloading and installing the TCS 
installer. 

Improvement 12.1: TBC 
Coordinate System 
Manager 
 

We offered for our clients the use of either the Inpho standard coordinate 
systems or the newly implemented TBC Coordinate System manager. This 
provides a big variety of projected coordinate systems and facilitates the 
interaction with Trimble Business Center. 

Improvement 12.1: Check 
about erroneous data 
formats 

Importing the GNSS/IMU file in the Project Editor a check about format 
consistency takes place. In case of discrepancies, a warning will inform the 
user about it. 
 

 
 

Fix 12.0.2: JPEG2000 
handling in the Image 
Converter 
 

Two problems have been fixed when using JPEG2000 input images for 
conversion 

1) The output images are TIFF images but generates with the 
extension JP2 

2) The conversion of the image overviews has been erroneous  
 

Fix 12.0.2: Crash of Image 
Commander 

In rare cases it could happen that the Image Commander crashed when 
several image folders were read one after the other. 
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Change 12.0.2: 
Information window 
“Basics” 

When setting up a new project, a “Basics” window appeared together with 
the Project Editor dialog, which indicated that a local coordinate system 
assumes that alle the data to be loaded must be present in the same 
projection. 
This window now only appears if an LSR system is actually selected. 
 

Improvement 12.0.1: 
Shortcuts to facilitate the 
measurement of fiducial 
marks (interior 
orientation) 
 

Shortcuts have been added for the measurement workflow of fiducial 
marks: 
“B” (previous) and “N” (next) for selecting the fiducial marks in the list.  

Improvement 12.0.1: 
Distortion graph in the 
camera editor 
 

Previously only the radial component was shown in the distortion view of 
the camera. Now the radial and tangential distortions are taken into 
account. 

Improvement 12.0.1: 
Validation checks against 
limitations 
 

The test of the suitability of the software in relation to its intended use has 
been updated. The suitability test is based on the limitations of the 
software product. Corresponding messages appear in the “Output log” 
when the project is loaded. 
 

Fix 12.0.1: Numerical 
sorting of the strips 
 

The checkbox setting “Sort ID numerically” in the strip menu was not kept 
when leaving the window. The next time opening the strip menu the alpha-
numeric sorting (1, 10, 2, 20, 3...) was activated.  
Now the default sorting for the strips is “numerically”. 
 

Information 12.0.1: 
Backward compatibility of 
license 

When using version 11 with a version 12 license, please make sure to 
install the patch 11.0.5 or higher. Lower versions will not be able to read 
the license of version 12. 
 

Improvement 12.0: 
Significant time saving 
when setting up large 
projects 

The performance and responsiveness of the Project Editor is significantly 
improved. You will mainly notice this when importing images and 
GNSS/IMU data. This is of great benefit for multi-head and large projects. 
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Improvement 12.0: 
Parallelization of the 
colorizer 
 

Starting the Colorizer from the GUI, will allow to run the process with 
parallelization. The Colorizer will start as many processes as there are 
(logical) CPU cores available. 

Improvement 12.0: Use of 
high-performance 
graphics card 
 

If the computer is equipped with an on-board and a high-performance 
graphic card, the high-performance graphic card is automatically selected 
for all calculation steps. 

Improvement 12.0: 
Adaption of the data to be 
loaded 
 

When opening a project with existing orthophotos, these were loaded, 
which led to long waiting times for larger projects. The standard setting of 
version 12 now only load a possibly existing backdrop image. This setting 
can be changed in the Preferences. ApplicationsMaster must be restarted 
after a change. 
 

New feature 12.0: Import 
of points and 
measurements. 
  

The Project Editor of version 12 offers the possibility to import object 
points with their measurements from another project (Project Editor > 
Points > Import).  
An export of the points (without measurements) is possible too, different 
formats are available (*.gcp, *.csv, *.txt, *.dat) 
 

New feature 12.0: 
“Points” dialog allows to 
add single points 
 

The Project Editor’s “Points” dialog allows to “Add” single points that are 
available in the project (target) coordinate system. It is not possible to 
transform points, which are given in a different coordinate system during 
the import. 
 

New feature 12.0: Camera 
dialog offers the support 
for Wild RC5 and Wild RC8 
 

It is now possible to define a camera based on the camera protocols for 
Wild analog cameras. The camera protocol defines the fiducial marks with 
distances. These distances can now be entered into a calculator, which 
provides the fiducial mark positions in photo coordinates. The camera 
dialog has been improved additionally to support and consider the rotation 
of the PPA/PPS coordinates. 
 



 

P a g e  21 | 45 
 

New feature 12.0: 
Compare cameras 
 

The use of additional parameters in MATCH-AT (Create grid camera) and 
inBLOCK or a camera calibration with inBLOCK will create a sub-set of the 
active camera. The “latest” camera sub-set becomes active and will be 
used automatically for further processing. The camera dialog offers now a 
new function comparing camera sub-sets in the camera dialog of the 
Project Editor. Right-click on the camera sub-set you want to compare and 
select from the context menu a second camera sub-set for comparison. 
The function opens a table with the two cameras, allowing an easy 
comparison of the camera entries. 
  

New feature 12.0: Vector 
file information 
 

 
 
The new functionality under “Tools > Vector File Information” makes it 
possible to create PDF files with the file information for each given file 
separately. 

Change 12.0: Simple 
orientation export 
 

ApplicationsMaster offers at Project Editor > Frame Photos dialog a simple 
export of image orientations. After selecting all or few images in the photo 
table, the export allows a simple text format with [comma, space, tab] 
delimiters. In addition to the export of [ID, East X, North Y, Height Z, 
Omega, Phi, Kappa] we added a header with the coordinate system 
information. By default, the text file uses *.ori as extension. The function 
was also part of the File > Export-Simple ORI, but has been removed from 
this place to avoid redundancy and possible misunderstandings. 
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Fix 12.0: Pyramid 
generation of TIFF images 
with EXIF information 
 

TIFF images can include additionally to the RGB values, additional 
information in the header, e.g. EXIF information and XML/XMP 
information. Transferring these EXIF and XML tag information of the source 
image to the target TIFF image (including pyramid levels) has been fixed 
and does not cause crashes. 
 

MATCH-AT / Satellite Georeferencing 

Change Description 

Improvement 12.1.1: 
Reasonable pre-settings 
for the “Refine Initial EO” 
workflow 
 

The previous pre-settings made no sense. Therefore, the default settings 
for the “Refine Initial EO” workflow were changed as following: 

 
 

Fix 12.1.1: Deleting photos 
in the PMT 

 

If an image was deleted in the Multi-Photo-Measurement Tool, all points 
contained in it were also deleted in the overlapping images. Now only the 
image measurements of the deleted images disappear but remain in the 
overlapping ones. 
 

Fix 12.1.1: IO – Sorting by 
ID and strips not possible 
 

The column sorting has been corrected for the Interior Orientation and it is 
now possible to sort image and strip IDs that contain non-numeric 
characters. 
 

Fix 12.1.1: Change point 
type in PMT 
 

Changing the point type in the Multi-Photo-Measurement Tool only 
worked if the measurement mode was not started before. After starting 
and exiting the measurement mode, it was no longer possible to change 
the point type in the point settings. Only a restart of the PMT made the 
change possible. This problem is now fixed. 
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Fix 12.1.1: PMT measure 
mode “semi-automatic” 
 

Using the “semi-automatic” mode for measuring (ground control) points by 
roughly measuring the point position in each image in which the point 
appears, then selecting the “semi-automatic” mode and accurately 
measuring the position in one photo will work again. 
 

Fix 12.1.1: PMT measure 
mode “full-automatic” 
 

The “full-automatic” mode for point measurement in the PMT works again.  

Fix 12.1.1: Tie point 
extraction for projects 
with big height differences 
 

Optimization for projects with big height differences and fixed flying height 
above terrain. The tie point center generation for such projects now works 
correctly. 

Fix 12.1.1: PDF Report file. 
Incorrect indication of the 
RMS values in “Exterior 
orientation evaluations” 
 

In the “Exterior orientation evaluation” of the PDF report, the “RMS Ds” 
values are now indicated correctly and only images with values above the 
threshold get listed. 

 

Fix 12.1.1: Project file 
entries in OrthoMaster 
resulted in rotated images 
in the PMT 
 

If a project file was loaded and saved in OrthoMaster while a height model 
was loaded, images could appear rotated in the PMT Topo Viewer 
afterwards. However, this had no influence on the actual processing.  

Fix 12.1: Long project 
names/paths 
 

The tie point extraction was disturbed or failed completely if the project 
name or path was extremely long. Now a message has been introduced to 
notify the user of this. 
 

Improvement 12.0.2: Stop 
process if sigma0 is too 
high 
 

A new termination criterion has been introduced for the MATCH-AT 
process. If the adjustment in the current MATCH-AT level exceeds a sigma0 
of > 3 pixels, the process is aborted. This prevents long processing times for 
unsuccessful (non-iterating) MATCH-AT runs. 
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New Feature 12.0.1: 
Visibility of ground control 
point IDs in the Multi-
Photo Measurement Tool 
 

The PMT now offers the option of treating the 
visibility of the GCP IDs separately from the 
point IDs. You can choose whether all point 
IDs should be invisible (default) or the IDs of 
the control points should remain visible. If the 
“Keep GCP ID” checkbox is activated, the GCP 
IDs are retained if the “Point ID Text” 
checkbox is deactivated. 

 

Fix 12.0.1: Status of 
inBLOCK report file (.pdf) 

For version 12 it was implemented that the report file for an inBLOCK run 
was automatically generated and written to the project directory. 
Unfortunately, we noticed that this was not up to date, as the project had 
to be saved beforehand. Therefore, the automatic generation of the PDF 
report file after each adjustment is removed. The report can now be 
generated form the menu: Data > Export > Adjustment Report. 
If the project has not yet been saved, the message to save the project 
appears when you call “Export > Adjustment Report”. The report file can 
only be written after the project has been saved. 
 

 
 

Fix 12.0.1: PDF report 
crashes if a project 
overview image is existing 
 

The report generator tries to write the project overview image to the 
report file. Because of the use of different libraries, this process crashed 
when inBLOCK was used. 

Fix 12.0.1: Calculation of 
TPCs takes long time 
 

With negative coordinates in X and Y for the EO, the calculation of the tie 
point centers took a very long time. This has been fixed. 

Fix 12.0.1: PMT crash 
when removing images 
 

The problem that the PMT crashed when images are removed is fixed. The 
PMT no longer crashes and the project is saved correctly. 
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Improvement 12.0: 
Limitation of image 
connections has been 
extended 
 

So far, identical points have been extracted in up to 99 images. In case of 
higher overlaps, further images in which the corresponding point would 
have been present were not connected. This limit value has been increased 
to 999, i.e. an identical tie point can exist in up to 999 images. 
This also applies to the measurement of control points or manual points, so 
that a point can now be measured in up to 999 images. 
 

Improvement 12.0: New 
algorithm for tie point 
generation 
 

The new algorithm for the tie point extraction provides a better success 
rate, stronger point connectivity, more multi-ray points that results in 
better or equal accuracy than the previous algorithm. Nevertheless, the 
user can decide for himself which method he would like to use. 

However, the user can decide which 
matching method he would like to use. Either 
the “New MATCH-AT” or the “Classic MATCH-
AT” checkbox can be activated in the 
“Matching” tab of MATCH-AT. 
 
 
 

Improvement 12.0: 
Automatic adaption of 
tpgprocc.ini to project size 
and overlap 
 

A highlight for version 12 is that the tpgprocc.ini file is automatically 
adapted to the project size and overlap. This means that there should no 
longer be frustrating aborts after hours/days/weeks of processing times, in 
which the limits in the tpgprocc.ini file had to be increased again and again. 
 

Improvement 12.0: 
Information in the Report 
file 
 

The MATCH-AT report file shows now uniquely described camera settings. 
There are four entries possible:  

 Camera process 
 Calibration status  
 Distortion type 
 Additional parameters 

The “Camera process” ON/OFF informs if any calibration was activated. 
The “Camera status” informs about INITIAL/UNCALIBRATED/CALIBRATED 
The “Distortion type” shows which distortion model is assigned to the 
camera: UNDEFINED/SIMPLE RADIAL/GRID/COEFFICIENTS 
The entry of “Additional parameters” indicates whether additional 
parameters were used and, if so, which ones. 
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Improvement 12.0: 
Creation of image stamp 
database 
 

The creation of the image stamp database in the Multi-Photo 
Measurement Tool (PMT) is now parallelized to run faster on first start-up. 

Improvement 12.0: 
Column width adaption in 
the Multi-Photo 
Measurement Tool 
 

The columns width in the PMT is now stored and does not change when a 
new item is selected. 
 

New feature 12.0: New 
shortcuts in the Multi-
Photo Measurement Tool  
 

The PMT offers new 
shortcuts for the 
measuring modes 
“Manual”, “Semi-
automatic” and “Full-
automatic”. 
 

New feature 12.0: Multi-
Aerial View “locked 
zooming” 
 

It is now possible to synchronize the zooming 
for all images – not only the actual one- when 
using the mouse wheel for zooming. This 
behavior will be available by toggling the 
corresponding tool button. 
 

New feature 12.0: 
inBLOCK automatically 
creates report file 
 

If you previously wanted to generate a report file after a calculation with 
inBLOCK, MATCH-AT had to be opened and “Create Report” executed 
there. Now, after a calculation with inBLOCK, the report file is 
automatically generated and written to the project directory. 
 

New feature 12.0: Export 
of inBLOCK listings now 
also in .csv format 
 

Version 12 now also offers the possibility 
to save the inBLOCK listings in a comma 
separated ASCII format (.csv). Until now it 
was only possible to save listing in RTF 
format, whereby the columns that did 
not fit the width of the page were cut off.  
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New feature 12.0: Export 
of selected points (PMT) 
 

 

The Multi-Photo Measurement Tool offers now exporting of selected 
points. The file will provide the adjusted coordinates for manual and 
automatic tie points and the adjusted coordinates followed by the original 
coordinates for ground control points. 
 

Fix 12.0: Crash using SIFT 
algorithm for tie point 
extraction 
 

The tie point extraction with SIFT method crashed when the SIFT algorithm 
created too many points. This buffer overflow has been fixed. Only the 
maximum allowed number of SIFT points are used. 
 

Fix 12.0: Missing update of 
boresight misalignment 
values in project file 
 

For multi-head projects, the boresight misalignment values calculated with 
inBLOCK were not updated in the camera entry. Thus, the values stored in 
the camera did not match the values output in the log file. This is now 
fixed. 
 

Fix 12.0: Use of DTM is not 
working properly 
 

The option for DTM use on the first level of the tie point extraction works 
now and is written correctly in the CNT file. 
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Fix 12.0: Save “Adjusted 
Drifts” and “Critical 
Points” 
 

inBLOCK offers the possibility to save the adjustment results in data lists 
such as the “Adjusted Coordinates” or the “Adjusted Orientations”. That 
was not possible for the lists of “Adjusted Drifts” and “Critical Points”. With 
version 12 these lists can now also be saved. 
 

Fix 12.0: Thin out in sub-
block deletes tie points of 
other (sub-) blocks 
 

When using the thinning functionality of MATCH-AT for a sub-block, it 
could happen that all tie points of the unused sub-blocks were deleted. 
This could also happen for multi-head projects where all viewing directions 
were organized separately in sub-blocks. Now it works perfectly. 
Performing a thinning does not delete tie points from unused sub-blocks, 
including the entire block. 
 

Fix 12.0: Scaling problem 
when using 4K monitors 
when measuring points. 
 

When using a 4K monitor (Windows scaling 250%) for the measurement, it 
could happen that the measured point was next to the actual position of 
the mouse pointer. The reason was a scaling problem which has been fixed 
for this version. 
 

Fix 12.0: PMT 
measurement points, 
visibility in Block View 
 

If a manual point was measured in the Block viewer of the PMT it appeared 
as a pink cross, even if the point was not measured in the individual 
images. This made it easier to select the position of the manually measured 
points in the overall overview. This visualization did not work for the patch 
releases of version 11 but is now available again with version 12. 
 

Change 12.0: Changed 
default setting in inBLOCK 
 

So far the default setting (inBLOCK) for the GNSS drift was “stripwise”. This 
was changed to “global” with polynomial “1”, as this approach corresponds 
to today’s, more accurate, GNSS data. 
 

Change 12.0: Overview 
window  
 

The behavior of the PMT’s overview in the Main View is adapted to 4K 
monitors. It now appears in the upper left. It can be made visible/invisible 
via  
Options > Preferences > Workspace > Toolbars 
If this option is not visible, click “Reset” in the Preferences dialog (Options 
> Preferences > Workspace > Toolbars). 
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MATCH-3DX / Meshing add-on 

Requirements/recommendations: 

We recommend an up-to-date computer with at least 32 GB RAM (better more). Furthermore, we 
recommend an additional hard disk for processing purposes only. The required disk space should be about 
2-5 times of the space that the input data requires. 
 

Change Description 

Improvement 12.2: 
Additional quality preset 
 

The quality presets “Low” (1:4), “Medium” (1:2), “High”(1:1) are 
reorganized and enhanced.  

Now the preset “Low” defines the resolution level 1:8, “Medium the level 
1:4, “High” the level 1:2 and “Highest” the original resolution 1:1. 
 

Improvement 12.2: 
Optimizing results for 
quality level  

The quality presets "High", "Medium" and "Low" have been optimized to 
better match the quality and performance to the selected quality level. For 
example, the quality preset is now taken into account for the resolution of 
the mesh texture. 
 

Improvement 12.2: 
Project directory path 
length 

The project directory path can now be longer without hitting the Windows 
maximum path length limitation during processing. In addition, the 
executables now support the Win 10 long path functionality (if enabled) to 
allow for even longer paths. This also applies to the path length of the 
TEMP directory in which the intermediate results are saved. 
 

Improvement 12.2: 
Optimized SLPK results 
 

Degenerate faces are now removed from the “Esri Scene Layer Package” 
(SLPK) results. These can be problematic when working with the results in 
other software. 
 

Improvement 12.2: GPU 
processing related 
messages 

 

Version 12.2 provides better GPU (CUDA) processing messages. For 
example, it’s now transparent whether GPU processing is enabled or why it 
can’t be used. 

Improvement 12.2: 
License error codes 
 

Some license errors that previously only reported error codes now have 
messages. 
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Change 12.2: GPU (CUDA) 
for compute capability 3.0 
or 3.2 
 

GPU (CUDA) processing is no longer supported when using a GPU with 
compute capability 3.0 or 3.2.  

Fix 12.2: “Out of memory” 
error’ 

In rare cases, an “Out of memory” error could occur in the Dense Matching 
step, although sufficient memory was available. 
 

Fix 12.2: Subpixel shifts The subpixel shifts of mesh textures are fixed. 

Fix 12.2: Minor 
inaccuracies 
 

Fixed some minor inaccuracies in applying camera distortion. 

Fix 12.2: Fallback to the 
CPU 

Fixed an issue where accessing the CPU could cause slowdowns when using 
an unsupported GPU. 
 

Fix 12.2: Backslashes in 
path of SLPK results 

Fixed some paths within the SLPK (Esri Scene Layer Package ) results that 
might have used backslashes, potentially resulting in problems when 
handling the files on Linux. 
 

Fix 12.2: Parameter 
update 
 

Fixed an issue where a parameter was not correctly updated when 
switching the scenario to “Default” from a different one. 

Fix 12.2: MATCH-3DX 
crashed during border line 
generation 
 

In case no height information is available (no adjusted points in .xpf file) 
and the coordinate system is a geoid based one, MATCH-3DX crashed 
during the border line generation for parallel access of height generation 
using an internal global height model. This happened more often the more 
threads were available. Now this process allows single access only which 
prevents a crash. 

Fix 12.2: Crash in 
automatic borderline 
generation – footprint 
intersection 
determination 

The surface generation process crashed during automatic borderline 
generation during the footprint intersection determination if more than 
two intersections per polygon part were available. Now more than 2 
intersection per polygon part are allowed. 
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Improvement 12.1.1: 
Introduced a warning that 
lists which formats do not 
allow the creation of un-
textured meshes 

The warning introduced shows that only the OSGB format allows the 
creation of un-textured meshes. Therefore, only this format should be 
activated.   
 

 

Note: Creating a textured mesh works for all formats. Then the checkbox 
“Provide texturing for generated mesh(es)” must be activated. 
 

Fix 12.1.1: Crash of the 
Image Rectifier for 1-
channel images 
 

The Image Rectifier works again for 1-channel images. 

Fix 12.1.1: Crash in DSM 
module 
 

On some hardware configurations, the SGM 2.5D process crashed. This issue has 
been resolved 
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Improvement 12.1: 
Optimized mesh results 

Version 12.1 offers faster loading and improved usability on low-end 

hardware and/or slow internet connections for LOD formats. This was 

achieved by reducing the triangle count and the size for the texture atlases. 

 

Improvement 12.1: 
Automatic shape file 
feature 

An automatic shape file feature is introduced, which will ensure that 

results are only produced in high-quality regions of the dataset in case no 

area of interest was defined. 

 

Improvement 12.1: 
Loading behavior for 3D 
tiles 
 

The loading behavior for 3D tiles (OGC/Cesium) output is strongly 

improved.  

Improvement 12.1: Higher 
texture quality 
 

The JPEG quality value has been increased, resulting in a higher texture 

quality for OGJ and DAE mesh outputs. 

Improvement 12.1: Tile 
name for every tile 
polygon 
 

The file “TilesShape.shp” now contains the tile name information for every 

tile polygon. This shape file can be found in the folder:  

\\pointcloud\Internal\Shapefiles\ 

Change 12.1: Information 
about stereo models 
 

The information about stereo models for dense matching is stored more 

efficiently, reducing disk space and RAM usage for large projects. 

Change 12.1: Faster 
loading times for GIS 
applications 
 

There are introduced “.vrt” files for raster products to enable faster loading 

times in GIS applications. 

Fix 12.1: Error  
“vector<T> too long” 
 

An issue is resolved where invalid polygons in area or correction shape files 

could lead to a “vector<T> too long” error. 

Fix 12.1: Correct 
referencing of TFW files 
 

TFW files are now correctly referenced to the center of the top left pixel. 
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Fix 12.1: Possible crash if 
dimensions in images and 
orientations are 
inconsistent 
 

An error message has been implemented which indicates that the 

dimensions in image and orientations are inconsistent. In the past this 

could lead to a crash if image preparation was skipped. 

Fix 12.1: DAE meshes and 
intended JPEG 
compression level 
 

An issue has been solved where textures of DAE meshes did not use the 

intended JPEG compression level. 

Fix 12.1: TilesShape.shp 
and multiple polygons 
 

Version 12.1 resolved an issue where the TilesShape.shp could contain 

multiple polygons per tile. 

Fix 12.1: Possible crash of 
for tiles with water points 
 

The point cloud generation could crash for tiles containing only water 

points. 

Fix 12.1: 16-bit to 8-bit 
conversion of images 
 

The 16-bit to 8-bit conversion of images during mesh texturing could lead 

to texture color artifacts. 

Fix 12.1: Artifacts in the 
results 
 

An issue is fixed where artifacts occurred in the results when using very 

large input images (more than 32766 pixels in at least one dimension) with 

certain orientation and project settings. 

 

Fix 12.1: Inconsistent color 
information 
 

Inconsistent color information of DRACO compressed and uncompressed 

meshes in SLPK mesh outputs could lead to issues when using them in 

other software. DRACO compression is now disabled by default for the 3D 

tiles (OGC/Cesium) mesh results so that it cannot negatively affect the 

performance when viewing the result with low-end hardware. 

 

Fix 12.1: Orientations 
using the Inpho 
coefficients distortion 
model 
 

When using orientations with the Inpho coefficient model, artefacts could 

occur in the results, especially in case of strongly distorted images. 
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Fix 12.0.1: Initial DEM 
generation for automatic 
borderline correction 
 

In order to assign the correct heights for the borderline, an initial DEM is 

generated. This generation would fail if the adjusted points used to 

generate the DEM have a standard deviation of zero. Now the object point 

standard deviation from the project is used to avoid null values.  

 

Improvement 12.0: 
Optimized workflow 
 

Checking the image properties and validity at the beginning of processing 

saves time and allows to determine the best settings for quality and 

performance. 

 Corrupt (open/read not possible) and missing images are excluded 

 Check for color channels to determine if texture enhancement can 
be activated for True Ortho and mesh generation 

 Optionally the image analysis results can be written into the log file 
(see changed/added MATCH.status file options: image type, tiled/ 
scan-lined image files, compressed/uncompressed, available RDX 
files, number of channel(s), number of bits per channel) 

 
GUI (MATCH.status handling) 

 The MATCH.status file can be accessed and edited via the user 
interface (MATCH-3DX Commander > View > Status file) 

 

Improvement 12.0: 
Quality enhancements 
 

Automatic 3D area borderline 

 In case no pre-defined area is given, an automatic borderline will be 
generated (for aerial and multi-head projects) to get clear True 
Orthophoto borders 
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Rectifier reduce undistorted images to valid image content 

 In case of huge image distortions, the image is cropped to the inner 
rectangle to avoid black pixels in the True Ortho. 
 

 
 
Optimized processing algorithms 
 

Improvement 12.0: 
Increased performance 
 

Optimized parallelization of rectifier. 
Optimized processing algorithms. 

Improvement 12.0: 
Optimized 3D Tiles mesh 
results 
 

Version 12.0 provides optimized 3D Tiles (OGC/Cesium) mesh results, for 
more responsive LOD refinement when opening the mesh in a viewer. 

Information 12.0: 
MATCH.status file 
 

MATCH-3DX automatically starts with the best fitting settings, for all 
options there are valid default values. 
Please adapt a setting only in consultation with the support team 
(imaging_support@trimble.com) 
 
In case you already use a MATCH.status file from a previous version, please 
check if there are defined settings, which changed for version 12 and adapt 
your MATCH.status file. 
The MATCH-3DX Commander (View > Status file) shows an available 
MATCH.status file. If there is not MATCH.status file in your project 
directory, a new with all possible settings and descriptions is generated 
automatically. 
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New settings: 
General 

 nocapacitycheck: disables the disk space check 

 numthreads: number of maximum threads 
 

Pre-check options 

 noprecheck: disables the pre-checking 

 image_analysis: adds additional image information to the log file 
(tiled/scanlined image files, compressed/uncompressed image files, 
available RDX files, number of channels and number of bits per 
channel) 
 

Image rectifier options 

 rectify: activate/deactivate image rectification 

 crop: Reduction of the undistorted images to the valid contents, 
black areas are cropped (negative value, e.g. -1). If the value is >0 
the image is cropped with the defined percentage on each side. 
 

Dense point cloud options 

 no_textureEnhancement: disables the texture enhancement for 
TrueOrtho and mesh texturing 

 no_onlineLogprogress: disables the online progress information in 
the log file 

 
Online models options 
Writes additional information into WINPUT files: 

 footprint 

 onlinemodel 
 
3D borderline options 

 noautousage: no application of automatic 3D area borderline 

 shrinkfactor: factor to shrink the planimetric 3D borderline 

 manualshift: manual height shift of automatic 3D borderline 
 

 noautoobique: no oblique images (>20 deg) for automatic 3D 
borderline detection 

 imgborder: percentage to influence automatic 3D borderline 
detection 

 minprjangle: minimum intersection angle for online models 

 area2wnp: 3D area borderline on WINPUT file 

 noautocorrection: avoids borderline refinement using an initial 
DTM 
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 dsrangefactor: factor to influence automatic 3D area borderline 
detection 

 AdjToOut: creates a LAS/LAZ file with adjusted points. Possible only 
in case 3D borderline generation is active. 

 
Changed options 

 no_rectify: changed to “rectify off/auto/on” where “on” is the 
default. This allows to force the rectification pre-process in any 
case. 

 
Eliminated options 

 textureEnhancement 

 logfileoutput 

 no_rectify 

 no_autoshapefile 
 

Change 12.0: Value range 
of non-empty pixels 
 

The value range of non-empty pixels in the TrueOrtho / DSM Ortho results 
is now limited to 1 to 254 (8 bit) or 255 to 65279 (16 bit) to enable better 
“no-data” handling. 
 

Change 12.0: Usage of 
AVX instruction set 
extensions  
 

Version 12.0 is using the AVX instruction set extensions for making better 
use of the hardware. 

Fix 12.0: Missing parts of 
the mesh 
 

The problem where parts of the mesh could be missing when exporting 
OBJ or DAE meshes has been fixed. 

Fix 12.0: Incorrect heights 
in the Cesium and SLPK 
meshes 
 

Heights in the Cesium and SLPK mesh formats could be incorrect, especially 
when using a project coordinate system with non-metric units. 

Fix 12.0: Mesh texturing 
errors 
 

In certain situations, the mesh texturing process could result in a “could 
not read file” and/or “access window out of range” error.  

Fix 12.0: 3D mesh process 
could fail 
 

The 3D mesh process could fail with an  
“assert_texture.rows == m_cam.getHeight() failed” error.  
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Fix 12.0: Number of 
indices in Cesium meshes 
using Draco compression 
 

The number of indices in Cesium meshes was incorrect when using Draco 
compression. This could lead to problems when loading the mesh in a 
viewer. 

Fix 12.0: DSM generation 
problems when using 
certain waterbody shape 
files 
 

The DSM step could get stuck before starting the interpolation part when 
using certain waterbody shape files. 

Fix 12.0: Decreased 
quality in dense matching 
for “noisy” projects 
 

The quality of DSM and TrueOrtho / DSM Ortho could decrease in datasets 
with a lot of noise in the dense matching results. 
 

Fix 12.0: Data gaps For projects that were flown with cameras with a long focal length, the 
MATCH-3DX results could show data gaps. 
 

Fix 12.0: Missing texture 
in the LOD mesh 
 

Textures could be missing in the LOD mesh formats for areas with low 
image coverage. 

Fix 12.0: “Out of memory” 
errors 
 

With version 12.0 some “Out of memory” errors are fixed that could occur 
on machines that have a low amount of physical memory. 

Fix 12.0: The dense 
matching step could get 
stuck 
 

The dense matching step could get stuck if very little memory was 
currently available. 

Fix 12.0: LOD rendering 
problems 

An issue that could lead to LOD rendering problems for Cesium meshes is 
fixed. 
 

Fix 12.0: Image 
preparation stopped 
 

The image preparation could stop with a “failed to read directory at offset 
…” error message when using very large input images. 

  



 

P a g e  39 | 45 
 

Fix 12.0: “Unrecoverable 
error during polygon 
meshing” error message 
 

The analysis step showed the error message “unrecoverable error during 
polygon meshing” for certain waterbody or correction shape files. 

Fix 12.0: Vertically shifted 
mesh results 
 

The SLPK mesh results were shifted vertically for certain project coordinate 
systems. 

MATCH-T DSM 

Change Description 

Fix 12.2: Crash in 
automatic borderline 
generation – footprint 
intersection 
determination 

The surface generation process crashed during automatic borderline 
generation during the footprint intersection determination if more than 
two intersections per polygon part were available. Now more than 2 
intersection per polygon part are allowed. 
 

Improvement 12.1: DTM 
process delivers colored 
point cloud 
 

MATCH-T DSM delivers now also for the Digital Terrain Model strategies a 
colored point cloud. 

Improvement 12.1: 
MATCH-T DSM calculation 
despite missing images 
 

MATCH-T DSM starts the calculation even if not all imaged defined in the 
project are available. A list of missing files is announced in the project log 
file. The MATCH-T<area>.log file reports the number of missing images.  
In previous versions, MATCH-T DSM did not start the calculation if defined 
images were missing. 
 

Fix 12.0.2: Gaps in the 
point cloud 
 

An error in the footprint intersection causes incorrect online model areas. 
This generated gaps in the point cloud. 

Improvement 12.0: User 
interface, MATCH.status 
 

The MATCH.status file can be generated/opened/edited directly from the 
user interface. Previously it was necessary to create the MATCH.status file 
manually in order to be able to edit the file via the GUI. If the 
MATCH.status file is called via the GUI but does not exist, it is created 
automatically. The options can then be edited. 
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New feature 12.0: New 
options for the 
MATCH.status file 
 

MATCH-T DSM automatically starts with the best fitting settings, for all 
options there are valid default values. 

Please adapt a setting only in consultation with the support team 
imaging_support@trimble.com 

When using the View status file in the user interface, you see the available 
MATCH.status file. If there is no status file in your project folder then a new 
one with all possible settings and descriptions is generated automatically.  

New options: 

 PtsNoPreFilter:   disables the pre-filtering of the 3D point cloud 

 area2wnp:   write the 3D area borderline on WINPUT file 

 manualshift:   height shift of automatic 3D area borderline 

 noautousage:   no application of automatic 3D area borderline 

 noprecheck 

 nocapacitycheck 
 

Improvement 12.0: Point 
cloud filter 

The point cloud will be filtered using a 3D filter before the grid 
interpolation and for each pyramid level. Thus, effects of mismatches to 
the grid interpolation will be reduced and their influence on further 
processing in the next pyramid levels will be minimized. This will result in 
less noises in the point cloud. 
With the command line option  
PTsNoPreFilter 
this option will be disabled. 
 

Improvement 12.0: 
Terrain mode 
 

So far, the TERRAIN modus (grid points for point cloud points) is used for 
FBM/LSM matching type. Now it is used only for Terrain generation 
regardless of which matching type is used. That means for Surface 
generation the FBM/LSM matching type can be used without the TERRAIN 
modus. 
 

mailto:imaging_support@trimble.com
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Improvement 12.0: 
LAS/LAZ handling 
 

The existing LasZip option on the GUI referred just to the resulting point 
cloud. Now this option is applied consequently to all resulting LAS files. 
Therefore, the description of the check box on the GUI has changed. 
 

Fix 12.0: Crash using 
FBM/LSM for big projects 
 

In some cases the project could crash during point cloud generation with 
the FBM/CBM method for large projects. 

 

DTM/Point Cloud Processing - DTMToolkit  

Change Description 

Fix 12.1.1: Use of SCOP++ 
filter methods 
 

Although the correct license was available, the SCOP++ filter methods 
could not be selected and were grayed out. 
 

DTMaster Stereo 

Change Description 

Fix 12.2: Cursor “Move 
Point”  

The “Move Point” cursor introduced for version 12 was not 
practical because it covered a large area of the image and it was 
no longer possible to move it exactly to a specific point. 

The cursor used up to version 11 was discrete and left a lot of 
screen area free, which facilitated precise snapping to individual 
points. 

Therefore, the cursor shape has been changed and now appears again as in 
version 11. 
 

Fix 12.2: Crash when 
undocking stereo window 
 

DTMAster crashed when undocking the stereo window on one monitor and 
moving it to another if the monitors did not have the same DPI scale (pixel 
density). 
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Fix 12.1: Missing ortho 
display 
 

The display of orthophotos works again. Tool tips have been added for 
“Show active photos/orthos” and “Show inactive photos/ortho frames”. 
Note: The background image is treated as an active orthophoto for the 
setting in Preferences: Display > View – Background image 
 

Change 12.0.2: Display of 
model area 
 

The visibility of the model area in the stereo view is shown as a rectangle. 
This rectangle was hidden for version 11 and 12 after a short time. For 
12.0.2, the model area border is now displayed permanently again. 
 

Restriction 12.0.2: Display 
of orthophoto content 
 

The problem of version 12, that the content of the loaded orthophotos is 
not displayed, but only the footprints are shown, has not yet been solved. 

Fix 12.0.1: Multiple clicks 
on the import “Finish” 
button resulted in 
multiple imports of the 
same data 

The import wizard loaded the files several times if the “Finish” button was 
clicked repeatedly while importing data. This resulted in duplicate points in 
the exported files. It is now no longer possible to select the “Finish” button 
during the import process.  
The quick import could be started in parallel with the same input file. Now 
it is no longer possible. 
 

Fix 12.0.1: Loading project 
files with active images 
took very long 
 

DTMaster always displayed all active images while opening a project. The 
under Preferences defined option “Display images = none” was not 
considered. 
Now the behavior is again like in previous versions. When loading images, 
only the footprints are displayed. As a new feature, we have added that the 
last status of the buttons “Display Photos”, “Display Photo Frames”, 
“Display Orthos”, “Display Ortho Frames” are saved in the registry when 
DTMaster is closed.  
 

Fix 12.0.1: Function keys 
cannot defined as 
shortcuts 
 

It was no longer possible to use functions keys as shortcuts. E.g. the 
selection of F1 as shortcut led to an assignment of P. 
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New feature 12.0: User-
defined visibility of 
orthophotos 
 

It is possible to select in the Options > Preferences > Views either to show 
or to hide the visibility of the backdrop image. 
The visibility of photos and orthos can be toggled individually on Photos 
and Orthos tab and additionally from the actions in the toolbar. It is 
possible to define shortcuts to toggle photos, orthos and its frames 
(Preferences > Workspace > Shortcuts > Category Display) 
 

OrthoMaster 

Change Description 

Fix 12.1: Display DTM 
preview and attributes 
 

The preview of DTM files during import and the display of the DTM 
attributes can be shown again. In addition, the no-data flag is now also 
recognized for images other than 16-bit TIFF images. 

Fix 12.1: Crash during start 
 

A crash that could occur when starting OrthoMaster has been fixed. 

Fix 12.0.1: Distorted 
footprints 
 

Loading a SCOP.dtm file into OrthoMaster, the image footprints looked 
distorted, some vertices seemed far away. This is corrected with version 
12.0.1. 

Fix 12.0.1: Import of 
ERMapper raster files 

The height model import of ERMapper raster files was temporarily not 
working. This has been fixed. 
 

Information 12.0.1: 
TopPit*.tol format 
 

The import of the TopPit*.tol format has been removed from the user 
interface. 

Improvement 12.0: 
Increased ortho-
rectification performance 

High performance CPUs are now 
utilized to a higher capacity. 
Depending on the hardware 
specification and project 
configuration this increases the 
performance in the range of 3-4 
times. 
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OrthoVista 

Change Description 

Fix 12.1.1: Crash in Seam 
Editor 
 

In rare cases the creation of a seam polygon led to a crash. 

Fix 12.0.2: Straight seam 
lines 
 

The problem that for some constellations the Feature Detection with 
building outlines created straight lines has been resolved. 

Improvement 12.0.1: 
Increase in performance 
of the Global Tilting step 
 

By improving the performance, the Global Tilting step can be processed in 
about half the time, whereas the Feature Detection and Seam Region 
process could be improved only slightly. 

Fix 12.0.1: Background 
Checking with 16 Bit 
images 
 

An issue in the Background Checking with 16 Bit images, where big parts of 
the images were not displayed properly, is fixed. 

New feature: 12.0: 
Transparency/alpha 
channel 
 

This new option allows adding an alpha (transparency) channel 
representing the background mask for the output image. The option is 
available in the “TIFF Options” for the “Output Image Format”. 
 

 
 

Improvement 12.0: 
Keyboard shortcuts 
 

The keyboard shortcuts get now recognized also when another window of 
the application (e.g. Project Dialog or Image Viewer) is on focus. This helps 
especially in the seam line editing process. 
 

DPMaster Distributed Processing 

Change Description 

Improvement 12.0.1: 
Updated documentation 
 

The reference manual of DPMaster has been updated for version 12. 
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New feature 12.0: Assign 
machine for job 
processing 
 

Right-click on job opens menu to start the job on a selected machine. 
Already started jobs will be restarted. 
 

 

New feature 12.0: Local 
processing directory 
 

This new option in the OrthoMaster and MATCH-3DX job setup allows the 
usage of a local processing (scratch) directory where all input images will 
be copied that need to be processed in this job. The local processing 
directory needs to be defined in the “Configure ...” dialog for each 
machine. The files will be removed after results were copied to the final 
output directory. 
 

 
 

New feature 12.0: Unique 
Condor directory 
(internal) 
 

Each submitted job is now internally handled in a single processing folder. 
This improves the jobs overview and helps during error search. 

Information 12.0:  
HT Condor version 9.0 
 

Due to the problems with the newest HT Condor version 9.0 the update 
of this version is not supported. 

 

Information 

For more information, please contact your Trimble Inpho Support Team at imaging_support@trimble.com. 
The software is available for download on https://geospatial.trimble.com/inpho-download 

mailto:imaging_support@trimble.com
https://de.geospatial.trimble.com/inpho-download

